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1. Introduction

Let's start programming!

Astrobee can be controlled with an Android application called the Guest Science APK
(GS APK). First, setup your machine to build your application according to the instructions
in Chapter 2. Next, read Chapter 3 and create a GS APK. This chapter explains the game
APIs that operate Astrobee, such as moving Astrobee and getting camera images. Then,
try running the GS APK in the simulator environment. Chapter 4 describes how to use the
environment.
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2. Setting up your machine

First of all, set up a machine for programming.

2.1. Requirements

The machine must meet the following requirements.

64-bit processor
4 GB RAM (8 GB RAM recommended)

Ubuntu 16.04 (64-bit version) ( http://releases.ubuntu.com/16.04/)
or Windows 10 (64-bit version)

NOTE: If you want to run your program on your own PC, you need 8 GB of RAM (16 GB
RAM recommended) and Ubuntu 16.04. For details, please refer to 0

2.2. Setting up Android Studio
2.2.1. Installing components (Only on Ubuntu)

If you use an Ubuntu machine, you need these components.

openJDK8
ADB (Android Debug Bridge)
Gradle

Please install them with the following command.

sudo apt-get -y install openjdk-8-jdk adb gradle

2.2.2. Installing Android Studio

Please download Android Studio 3.4.1 from Android Studio download archives page
( https://developer.android.com/studio/archivehttps://developer.android.com/studio/index.ht
ml ) and extract it into your home directory.



http://releases.ubuntu.com/16.04/
https://developer.android.com/studio/archive
https://developer.android.com/studio/index.html
https://developer.android.com/studio/index.html
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2.2.3. Downloading additional components

To build the Guest Science APK, you need to download additional components as
follows.

1) Launch Android Studio.
2) Select [Tools] -> [SDK Manager].

3) On the SDK Platforms Tab, check “show Package Details”. Select “Android SDK
Platform 25” and “Android SDK Platform 26”.

4) On the SDK Tools Tab, check “show Package Details”. Select “25.0.3”, “26.0.2”
under Android SDK Build-Tools and “Android SDK Platform-Tools”.

5) Click the [Apply] button to install these components.
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3. Creating your application
3.1. Creating an Android project

To create your application, prepare a new project with the following steps.

1) Download APK template (Template APK) from the Download page on the Web site.
2) Extract the zip file to the directory where you want it.

3) Launch Android Studio.

4) Open the APK template folder with [File] -> [Open].

5) Open [app/javaljp.jaxa.iss.kibo.rpc.defaultapk /YourService.java] in Project view.

6) Write your code in runPlan1 — runPlan3 methods in the YourService.java file.

When you open APK template folder, “Android Gradle Plugin Update Recommended”
dialog may appear. However you must not update because of dependency problem, so
push “Don’t remind me again for this project”

Android Gradle Plugin Update Recommended X

To take advantage of the latest features, improvements, and security fixes, we strongly
recommend that you update the Android Gradle plugin from the current version 2.3.3 to
version 3.5.3 and Gradle to version 5.4.1. Release notes

Android plugin 3.2.0 and higher now support building the Android App Bundle—a new
upload format that defers APK generation and signing to compatible app stores, such as

Google Play. With app bundles, you no longer have to build, sign, and manage multiple
APKs, and users get smaller, more optimized downloads. Learn more

Update Remind me tomorrow Don't remind me again for this project

Figure 3.1-1 Android Gradle Plugin Update Recommended dialog

3.1.1. Game APlIs
(1) Writing the application

You can use the game APIs shown below in the YourService.java file.

‘runPlan1” is executed on the web simulator. You can choose any plan when you run
the application on your own machine.

public class YourService extends KiboRpcService {
[/ write your plan 1 here
@Override
protected void runPlan1(){
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}

/I start this run
api.judgeSendStart();

/I move Astrobee from the starting point to P1-1

Point point = new Point(1.1, -2.2, 3.3);

Quaternion quaternion = new Quaternion(4.4, -5.5, 6.6, -7.7);
api.moveTo(point, quaternion, true);

1 :
/I once Astrobee came to P1-1, get a camera image

Bitmap snapshot = api.getBitmapNavCam();

/l read the QR code in the image and get the x-axis coordinate value of P3
String valueX = .. ;

/I send the result to scoring module

api.judgeSendDiscoveredQR(0, valueX);

/l implement some other functions or repeat for P1-2, P1-3, ...
I

/I once Astrobee came to P3, get a camera image
Bitmap snapshot = api.getBitmapNavCam();

/I read the AR tag in the image

String markerld = .. .;

/I send the result to the scoring module
api.judgeSendDiscoveredAR(markerld);

/I some other functions
1

// turn on the laser light,
api.laserControl(true);

/l take snapshots to evaluate the accuracy of laser pointing and finish this run

api.judgeSendFinishSimulation();
sendData(MessageType.JSON, "data", "SUCCESS:defaultapk runPlan1");

Il write your other plans here
...

}

You can find methods of the game APIs by using the code completion function of

Android Studio.

Please refer to (2) for more information and you can download Sample APK from the

Download page on the Web site.
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(2) API details
Details of the Kibo-RPC’s game APlIs are listed below.
(2-1) Method Summary
Table 3-1 Method Summary

Modifier and Type Method and Description
gov.nasa.arc.astrobee.Re flashlightControlFront (float brightness)
sult Set Brightness of Front Flash Light

gov.nasa.arc.astrobee.Re flashlightControlBack (float brightness)

sult Set Brightness of Back Flash Light
android.graphics.Bitmap getBitmapDockCam ()
Get Bitmap image of DockCam.
android.graphics.Bitmap getBitmapNavCam ()
Get Bitmap image of NavCam.
jp.jaxa.iss.kibo.rpc.api getImu ()
-types.ImuResult Get IMU telemetry
static KiboRpcApi getInstance (gov.nasa.arc.astrobee.android.gs
.StartGuestScienceService startGuestScienceS
ervice)
Static method that provides a unique instance of this class
org.opencv.core.Mat getMatDockCam ()
Get Mat image of DockCam.
org.opencv.core.Mat getMatNavCam ()
Get Mat image of NavCam.

jp.jaxa.iss.kibo.rpc.api getPointCloudHazCam ()
-types.FPointCloud Get PointCloud data of HazCam.

Jjp.jaxa.iss.kibo.rpc.api getPointCloudPerchCam ()

-types.PointCloud Get PointCloud data of PerchCam.
gov.nasa.arc.astrobee.Ki getTrustedRobotKinematics ()
nematics

Get trusted data related to positioning and orientation for
Astrobee with infinite timeouts

gov.nasa.arc.astrobee.Ki getTrustedRobotKinematics (int timeout)

nematics Get trusted data related to positioning and orientation for

Astrobee




Version 2.3.3
Released Date: August 21st, 2020

Modifier and Type

Method and Description

void judgeSendDiscoveredAR (java.lang.String id)
Send an AR ID for judge.
void judgeSendDiscoveredQR (int no,
java.lang.String value)
Send a QR code data for judge.
void judgeSendFinishISS ()
Send finish command to do final operation at ISS.
void judgeSendFinishSimulation ()
Send finish command to do final operation in simulation.
void judgeSendStart ()

Send a starting time stamp for judge.

gov.nasa.arc.astrobee.Re
sult

moveTo (gov.nasa.arc.astrobee.types.Point goa
1lPoint,
gov.nasa.arc.astrobee.types.Quaternion orien
tation, boolean printRobotPosition)

Move Astrobee to the given point and rotate it to the given
orientation.

gov.nasa.arc.astrobee.Re
sult

relativeMoveTo (gov.nasa.arc.astrobee.types.P
oint goalPoint,
gov.nasa.arc.astrobee.types.Quaternion orien
tation, boolean printRobotPosition)

Move Astrobee to the given point using a relative reference
and rotates it to the given orientation.

void

shutdownFactory ()

This method shutdown the robot factory in order to allow
java to close correctly.
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(2-2) Method Details

° flashlightControlFront

public gov.nasa.arc.astrobee.Result flashlightControlFront
(float brightness)

Brightness of Front Flashlight

Parameters:
brightness - Brightness percentage between 0 - 1.

Returns:

A Result instance carrying data related to the execution.
Returns null if the command was NOT executed as a result of
an error

flashlightControlBack

public gov.nasa.arc.astrobee.Result flashlightControlBack
(float brightness)
Brightness of Back Flashlight

Parameters:
brightness - Brightness percentage between 0 - 1.

Returns:

A Result instance carrying data related to the execution.
Returns null if the command was NOT executed as a result of
an error

° shutdownFactory

public void shutdownFactory ()

This method shuts down the robot factory in order to allow java to close correctly.

getinstance

public
static KiboRpcApi getInstance (gov.nasa.arc.astrobee.android.gs.Sta
rtGuestScienceService startGuestScienceService)

Static method that provides a unique instance of this class

Returns:
A unique instance of this class ready to use

° getTrustedRobotKinematics
public gov.nasa.arc.astrobee.Kinematics getTrustedRobotKinematics (

int timeout)

Gets trusted data related to positioning and orientation for Astrobee

Parameters:
timeout - Number of seconds before canceling request

Returns:
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Kinematics Trusted Kinematics, null if an internal error
occurred or request timeout

° getTrustedRobotKinematics

public gov.nasa.arc.astrobee.Kinematics getTrustedRobotKinematics (

)

Gets trusted data related to positioning and orientation for Astrobee with infinite timeouts

Returns:

Kinematics Trusted Kinematics, null if an internal error
occurred or request timeout

° getimu
public jp.jaxa.iss.kibo.rpc.api.types.ImuResult getImu ()

Gets IMU telemetry

Returns:

ImuResult data, null if an internal error occurred.
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° getBitmapNavCam

public android.graphics.Bitmap getBitmapNavCam /()

Gets Bitmap image of NavCam.

Returns:

Bitmap image of NavCam (1280 px x 960 px), null if an internal
error occurred. Format:Bitmap.Config.ARGB 8888

° getBitmapDockCam

public android.graphics.Bitmap getBitmapDockCam ()

Gets Bitmap image of DockCam.

Returns:

Bitmap image of DockCam (1280 px x 960 px), null if an
internal error occurred. Format:Bitmap.Config.ARGB 8888

° getMatNavCam

public org.opencv.core.Mat getMatNavCam ()

Gets Mat image of NavCam.

Returns:

Mat image of NavCam (1280 px x 960 px), null if an internal
error occurred. Format:CV8UC1

° getMatDockCam

public org.opencv.core.Mat getMatDockCam ()

Gets Mat image of DockCam.

Returns:

Mat image of DockCam (1280 px x 960 px), null if an internal
error occurred. Format:CV8UC1

° getPointCloudHazCam

public Jjp.jaxa.iss.kibo.rpc.api.types.PointCloud getPointCloudHazC
am ()
Gets PointCloud data of HazCam.

Returns:

PointCloud data of HazCam(224 px x 171 px), null if an
internal error occurred.

10
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° getPointCloudPerchCam

public Jjp.jaxa.iss.kibo.rpc.api.types.PointCloud getPointCloudPerc
hCam ()

Gets PointCloud data of PerchCam.

Returns:

PointCloud data of PerchCam (224 px x 171 px), null if an
internal error occurred.

° moveTo

public gov.nasa.arc.astrobee.Result moveTo (gov.nasa.arc.astrobee.t
ypes.Point goalPoint,

gov.nasa.arc.astrobee.types.Quaternion orientation,

boolean printRobotPosition)

Moves Astrobee to the given point and rotates it to the given orientation.

Parameters:
goalPoint - Absolute cardinal point (xyz)

orientation - An instance of the Quaternion class. You may
want to use CENTER US LAB or CENTER JEM as an example
depending on your initial position.

printRobotPosition - flag which print robot positions in log
or not.

Returns:

A Result instance carrying data related to the execution.
Returns null if the command was NOT executed as a result of
an error

° relativeMoveTo

public gov.nasa.arc.astrobee.Result relativeMoveTo (gov.nasa.arc.as
trobee.types.Point goalPoint,
gov.nasa.arc.astrobee.types.Quaternion orientation,

boolean printRobotPosition)

Moves Astrobee to the given point using a relative reference and rotates it to the given
orientation.

Parameters:
goalPoint - The relative end point (relative to Astrobee)

orientation - The absolute orientation

printRobotPosition - flag which print robot positions in log
or not.

Returns:

A Result instance carrying data related to the execution.
Returns null if the command was NOT executed as a result of
an error

11
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° laserControl

public gov.nasa.arc.astrobee.Result laserControl (boolean state)

Turns power on/off Laser Pointer. If it is same state as input parameter, nothing happens.

Parameters:
state - Set a laser pointer true:power on / false:power off.

Returns:

A Result instance carrying data related to the execution.
Returns null if the command was NOT executed as a result of
an error

° judgeSendStart

public void judgeSendStart ()

Sends a starting time stamp for scoring.
You should call this function before you start your mission, otherwise your score is not
calculated.

o judgeSendFinishSimulation

public void judgeSendFinishSimulation ()

Sends finish command to do final operation in simulation. When this function is called,
snapshots of laser pointing accuracy are taken and they are used to scoring.

You should call this function once you have turned the laser on, otherwise your score is not
calculated.

o judgeSendFinishISS

public void judgeSendFinishISS ()

Sends finish command to do final operation at ISS. This function is for final round.

12
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judgeSendDiscoveredQR

public void judgeSendDiscoveredQR (int no,

java.lang.String value)

Sends a QR code data for scoring.

Warning:

1, Each pair of no and value is accepted only once.You should call this function once each
QR code has been discovered,otherwise your score is not calculated.

2, You DO NOT change a value read from QR code, you should send a raw string you read.

Parameters:

no - QR code number.
[Preliminary round, Simulation]
O:pos x, l:pos y, 2:pos z 3:qua X, 4:qua y, 5S:qua z

[Final round, ISS]
0:pos_x, pos_y, pPoOSs_z
l:qua x, qua y, qua z

value - string you read from QR code.
[Preliminary round, Simulation]
ex: pos x, 1.23456

[Final round, ISS]
ex: pos x, 1.23456, pos y, 2.3456789, pos z, 3.456

judgeSendDiscoveredAR

public void judgeSendDiscoveredAR (java.lang.String id)

Sends an AR ID for scoring.
You should call this function once an AR tag has been discovered, otherwise your score is
not calculated

Parameters:

id - AR code id you read.

13
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3.1.2. Type information
(1) Summary

Table 3-2 Type information summary

Type Description

jp.Jjaxa.iss.kibo.rpc.api IMU telemetry data.
.types.ImuResult

jp.Jjaxa.iss.kibo.rpc.api Point cloud data.
.types.PointCloud

(2) Details
Details of Kibo-RPC’s types are bellow.
(2-1) jp.jaxa.iss.kibo.rpc.api.types.ImuResult

o getAngularVelocity

public gov.nasa.arc.astrobee.types.Vec3d getAngularVelocity ()

Returns:

Angular velocity data.

° getAngularVelocityCovariance

public double[] getAngularVelocityCovariance ()

Returns:
Angular velocity Covariance data.

° getLinearAcceleration

public gov.nasa.arc.astrobee.types.Vec3d getLinearAcceleration ()

Returns:
Linear acceleration data.

° getLinearAccelerationCovariance

public double[] getlLinearAccelerationCovariance ()

Returns:

Linear acceleration covariance data.

14
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° getOrientation

public gov.nasa.arc.astrobee.types.Quaternion getOrientation ()

Returns:
Orientation data.

° getOrientationCovariance

public double[] getOrientationCovariance ()

Returns:

Orientation covariance.

(2-2) jp.jaxa.iss.kibo.rpc.api.types.PointCloud

° getWidth

public int getWidth ()

Returns:
Width of point cloud data.

° getHeight

public int getHeight ()

Returns:
Height of point cloud data.

° getPointArray

public gov.nasa.arc.astrobee.types.Point[] getPointArray ()

Returns:

Point arrays of point cloud data. It contains number of array
data Width times Height.

15
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(3) Reference

LKA

Please refer below for information about other Types.

Type

URL

gov.nasa.arc.astrobee
.Kinematis

https://github.com/nasa/astrobee android/blob/5b07e4d626781

a6f7e0a9cdf4397375cbe509803/astrobee api/api/src/main/jav
a/gov/nasal/arc/astrobee/Kinematics.java

gov.nasa.arc.astrobee
.Result

https://github.com/nasa/astrobee android/blob/5b07e4d626781

a6f7e0a9cdf4397375cbe509803/astrobee api/api/src/main/jav
a/gov/nasa/arc/astrobee/Result.java

gov.nasa.arc.astrobee
.types.Vec3d

https://github.com/nasa/astrobee android/blob/5b07e4d626781

a6f7e0a9cdf4397375cbe509803/astrobee api/api/src/main/jav
a/gov/nasa/arc/astrobee/types/Vec3d.java

gov.nasa.arc.astrobee
.types.Quaternion

https://github.com/nasa/astrobee android/blob/5b07e4d626781

a6f7e0a9cdf4397375cbe509803/astrobee api/api/src/main/jav
a/gov/nasalarc/astrobee/types/Quaternion.java

gov.nasa.arc.astrobee
.types.Point

https://github.com/nasa/astrobee android/blob/5b07e4d626781

a6f7e0a9cdf4397375cbe509803/astrobee api/api/src/main/jav
a/gov/nasalarc/astrobee/types/Point.java

16
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https://github.com/nasa/astrobee_android/blob/5b07e4d626781a6f7e0a9cdf4397375cbe509803/astrobee_api/api/src/main/java/gov/nasa/arc/astrobee/types/Quaternion.java
https://github.com/nasa/astrobee_android/blob/5b07e4d626781a6f7e0a9cdf4397375cbe509803/astrobee_api/api/src/main/java/gov/nasa/arc/astrobee/types/Point.java
https://github.com/nasa/astrobee_android/blob/5b07e4d626781a6f7e0a9cdf4397375cbe509803/astrobee_api/api/src/main/java/gov/nasa/arc/astrobee/types/Point.java
https://github.com/nasa/astrobee_android/blob/5b07e4d626781a6f7e0a9cdf4397375cbe509803/astrobee_api/api/src/main/java/gov/nasa/arc/astrobee/types/Point.java
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3.2. Building your application
3.2.1. On Ubuntu

To build your application, use the command shown below.

NOTE: DO NOT build your application using Android Studio to change the build task, as
this may cause an error.

$ cd <YOUR_APK_PATH>
$ ANDROID_HOME=$HOME/Android/Sdk ./gradlew assembleDebug
You can find the APK file as “<YOUR_APK_PATH>/app/build/outputs/apk/app-debug.apk”.

3.2.2. On Windows

Please build your application with the following steps.

1) Launch Android Studio.

2) Open <YOUR_APK_PATH>.

3) Click app on the [Project] window.

4) Select [Build] -> [Make Module ‘app’].

If you find errors, please build an APK file on an Ubuntu machine.

You can find the APK file as “<YOUR_APK_PATH>\app\build\outputs\apk\app-debug.apk”.
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3.2.3. Change the application ID (optional)

You can change the application ID (jp.jaxa.iss.kibo.rpc.sampleapk or
Jp-jaxa.iss.kibo.rpc.defaultapk by default).

In this step, we change the application ID to “jaxa.iss.kibo.rpc.myteam” and APK name
to “myteam” with the SampleAPK project.

NOTE: This instruction is for the final round. Changing application ID is not necessary
and not recommended in the preliminary round.

NOTE: “jaxa.iss.kibo.rpc” cannot be changed.

1) Launch Android Studio.

2) Open <YOUR_APK_PATH>.

3) Make sure you are viewing the project in Android View.
- i ’

: SampleApk

v % app

2 guest_science_llbrary
% kibo_rpc_apl
> » & Gradle Scripts

Figure 3.2-1 Android View
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4) Click on the setting gear icon and unselect [Compact Empty Middle Package].

Figure 3.2-2 Unselect [Compact Empty Middle Package]

5) Please expand the “java”

folder.

Figure 3.2-3 Expand the “java” folder

6) Right-click the "sampleapk" folder and select [refactor] -> [rename].
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7) Awarning will be displayed, but you go ahead and click [Rename Package]. After
that, enter theAPKname that you want. (In the picture, we rename to “myteam”.)

Rename

Refactor

Figure 3.2-4 Rename dialog

8) In the bottom of Android Studio, “Refactoring Preview” will be displayed. Here, click
[Do Refactor].

= Find: Refactoring Preview
y v Package to be renamed to myteam, Directory to be renamed to Jp.jaxa.iss.kibo.rpc.myteam

.sampleapk, package Jp.
iss.kibo.rpc.sampleapk, p

Figure 3.2-5 Refactoring Preview

9) Open build.gradle (Module: app) in Gradle Scripts on the left-side menu. Please
change the application ID and click [Sync Now].
r Build Run Too VCS Window Helf

= app v

Figure 3.2-6 build.gradle (Module: app)
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10) Open strings.xml in app -> res -> values on the left-side menu. Please change the
APK name and save.

Figure 3.2-7 strings.xml

You have successfully changed the application ID in Android Studio. And if you want to
change the Android project name and its directory name, follow the next steps.

(1) On Ubuntu

11) Close Android Studio.
12) Please execute the following commands.

cd <YOUR_APK_PATH>

cd ../

mv SampleApk <YOUR_APK_NAME>

cd <YOUR_APK_NAME>

mv SampleApk.iml <YOUR_APK_NAME>.iml

(2) On Windows

10) Close Android Studio.
11) Please rename a SampleApk folder to <YOUR_APK_NAME> with Windows Explorer.

12) Please rename a SampleApk.iml to <YOUR_APK_NAME>.iml in the SampleApk folder
with Windows Explorer.
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4. Running your program on the simulator
4.1. Using the simulator server

Once you have built your application, you can run it with the web simulator provided by
JAXA. To use the simulator, you need a user account issued by the Kibo-RPC secretariat. If
you don’t have one, please read the Kibo-RPC Guidebook to complete your application for
participation in Kibo-RPC first.

4.2. Login

Access the Kibo-RPC web site ( https://jaxa.krpc.jp/ ) and click “LOGIN”.

N - —

"'{. ¢ (xih_,.nm e ppron e ,,
L 5 = H 3 - =3 = 'k 5._»_ ” A

W

1SS with Rob

T e B s
Figure 4.2-1 LOGIN tab

On the login form, enter the ID and password for your team’s account, and click the
“LOGIN” button. If you have forgotten your ID or password, please contact the Kibo-RPC
secretariat.

' N ]
KiboIRGbotProgramming Challenge
i f?‘:f. & ,:.";a’n[‘-

save ISS with Robots!!l

Figure 4.2-2 LOGIN button
Now, you can access the web simulator from this page.

22


https://jaxa.krpc.jp/

Version 2.3.3
Released Date: August 21st, 2020

10w W 33 P Rl

Figure 4.2-3 Web simulator page
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4.3. Uploading the APK and running your program

On the simulation page, select your APK file and the simulator version, enter a memo if
desired, and click the “START SIMULATION” button.

........

Figure 4.3-1 START SIMULATION button

A simulation may take longer than 20 minutes to run, and it does not need your attention
while it runs. After starting your simulation, for example, you can log out, get a cup of
coffee, then go back to the web site.

When there is a simulation running, the simulation page displays its original information,
s0 you cannot run another simulation until it finishes.

If you want to stop your simulation, click the “TERMINATE SIMULATION” button. Note
that terminating a simulation loses its game score and output files (such as rosbag and the
Android Emulator’s log).

Kibo-RPC  svenen

Figure 4.3-2 TERMINATE SIMULATION button
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4.4. Checking simulation while running

When your simulation is running, you can log in to the simulator server (viewer) via your
browser. Click the “SIMULATIOR VIEWER” button to show the information for a remote
connection, and open the viewer in another tab by clicking the “VIEW” button.

SN XINORPC.  cavoims  wraravis [MSIAD svomnns  ron  cassss /S0 [N

Enter the password for your remote connection to log in. Now you can use rviz to see
how Astrobee moves in your simulation. This viewer is available until the simulation is
finished.

The viewer displays a real-time simulation in the view-only mode for the simulation
stability. You cannot operate the viewer..
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4.5. Checking the result
4.5.1. Result summary

Once your simulation has started, you can check the results by clicking the “VIEW
RESULT” button on the simulation page.

i Sypetemmems O

e “

Figure 4.5-1 VIEW RESULT button
On the result page, you can see the details of your simulation, such as the game time,
laser accuracy, and so on.

.......

000000
B
1

Figure 4.5-2 RESULT page
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4.5.2. Download ZIP file

You can get a ZIP file by clicking the “DOWNLOAD LOG FILES” button. This ZIP file
contains a game score, rosbag and the Android Emulator’s log. Note that some or all of
these files will not be available unless your simulation finishes properly. Besides the result
page, the game score also appears in a JSON file, which can be read using a text editor.

{
"QR": {
"0": {

"result"; true,
"timestamp": "19700101 000423792",

12
"AR": {

"result": true,
"timestamp™: "19700101 000552624",

}1
"Approach": {

"0": {

2

"direction": true,

"x": 1.22,

"y" -3.44,

"r" 4.12,

"timestamp™: "19700101 000646960",

"Mission Time": {

"start": "19700101 000021632",
"finish": "19700101 000822824"

}

27
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“result” is true if the value of the QR
code is correct.

“0”, “17, ... and 5" correspond to P1-
1, P1-2, ... and P2-3.

“result” is true if the marker ID of the
AR tag near Target is correct.

“direction” is true if the laser shot is
on the Target plane.

“

r’ is the distance between the center
of Target and the laser shot.

“0”, “1”, ... and “9” correspond to the
1st, 2nd . and 10t snapshot.

The average distance is referred to
as “Laser Accuracy’.

“Game Time” is the difference
between the “start” time and the
“finish” time.
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4.5.3. Check simulation after running

To check previous simulations, click the “Results” button on the simulation page. The
results page lists your past simulations. This list can hold up to 20 simulations.

.!'_—"E"""F’:q :ﬁ:

Figure 4.5-3 Results list page

The “VIEW RESULT” button is the same as the one on the simulation page. Please be
careful when you click the “REMOVE RESULT” button; it removes the output files of the
selected simulation and the removed result will be lost.

You can play the rosbag (simulation result) at 0.5x — 3x speed with the viewer. You can
change rosbag replay settings and rviz settings. In detail, it is described below sections.
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4.5.4. rosbag replay settings

You can change rosbag replay settings using Rosbag Player.

Figure 4.5-4 Rosbag Player

- PlayConfig C1E Type Description
T Speed Select replay speed.
- Slider
= Range Select replay range.
Selector
d do 0 Play Start replay and open rviz window.
Button If rviz already has opened, it will restart.
Pause Pause replay.
Push Push
Button
[Play] [Stop]
____________ Resume | Resume replay.
Button
D FPlayControl (=
Pause Stop Stop Stop replay and back to PlayConfig
Push Push
[Pause] [Resume]

‘- FlayControl =

Resume
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4.5.5. rviz settings

You can change display settings on rviz window.

Table 4-1 rviz configuration

Item Check box in the “Displays” tab
Planning trajectory [Visualize]->[PlanningTrajectory]
Trajectory [Visualize]->[Trajectory]
KeeplnZone/KeepOutZone [Visualize]->[Zones]

NavCam [Sensors]->[NavCam]
DockCam [Sensors]->[DockCam]
HazCam [Sensors]->[HazCam]

KeepOutZone
(Red transparency box)

A |
PIanningtrajectory/ LS

(Green line)

_ Trajectory
(Light blue line)

//
KeepInZone
(Green transparency box)

Figure 4.5-5 rviz configuration description
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4.6. Running on your own machine (optional)

You can also run the program on your own machine. This chapter provides a procedure
to set up the Astrobee simulator. You get a simple simulation environment without
randomness modules (Air flow simulator and Objects randomness generator) or judge
module.

4.6.1. Differences between web simulator and local
simulator

External Modules for Local Simulation Environment does not include random factor
modules (Object position, airflow and navigation error).

You can test and debug your program using local simulator, but need to evaluate it on
web simulator server in order to obtain a high score in the preliminary round.

4.6.2. Requirements

The following requirements are needed to set up a simulation environment on your
machine.

64-bit processor
8 GB RAM (16 GB RAM recommended)
Ubuntu 16.04 (64-bit version) ( http://releases.ubuntu.com/16.04/)

4.6.3. Setting up the Astrobee Robot Software

Clone code from GitHub ( https://github.com/nasa/astrobee ) and install Astrobee Robot
Software according to the installation manual.
( https://github.com/nasal/astrobee/blob/70e3df03ff3f880d302812111d0107f3c14dcccO/INS

TALL.md)

NOTE: Since the web simulator is running Astrobee Robot Software v0.10.2 and
Android submodule v0.8.0, so please execute the following command after clone the
android software repository.

pushd $SOURCE_PATH
git checkout 70e3df03f3f880d302812111d0107f3c14dcccO

popd
pushd $ANDROID_PATH
git checkout 5b07e4d626781a6f7e0a9cdf4397375cbe509803

popd
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After building the source code, execute the following commands in order.

pushd $BUILD_PATH
source devel/setup.bash

popd
roslaunch astrobee sim.launch dds:=false robot:=sim_pub rviz:=true

Is the image below displayed on your screen? If so, installation is complete!

O DEBUC: NavCam

No Image
@ DEBUG. DockCam

No Image

B oisplays
ve Dptions

(TTTIT ]

Figure 4.6-1 Setup result
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4.6.4. Creating the AVD ( Android Virtual Device )

Create an AVD ( Android Virtual Device ) as follows.

1) Launch Android Studio.

2) Select [Tools] -> [AVDManager].

3) Inthe Android Virtual Device Manager Window, click [+ Create Virtual Device ...].
4) Select device Nexus 5 ( Resolution 1080x1920 ) and click [Next].

5) Select the [x86 Images] tab, choose Nougat/API Level 25/ABI x86_64/Android
7.1.1(NO Google APIs), then click [Next].

NOTE: Download the system image if you need it.
6) Setthe AVD name to “AstrobeeAndroidSim”.
7) Click [Finish].

In the Android Virtual Device Manager window, you will see “AstrobeeAndroidSim” in the
list.

Click the Play button in the Action column. If the AVD launches successfully, the
following image is displayed.

Androld Emulator - AstrobeeAndroidSim:5554

. ®©.401212

Search *

Email Gallery

Figure 4.6-2 Android emulator screen
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4.6.5. Building the Guest Science Manager APK

To run your program, you must install the Guest Science Manager APK. (Details at
https://github.com/nasa/astrobee android/blob/5b07e4d626781a6f7e0a9cdf4397375cbe50
9803/guest_science readme.md )

Execute the following commands in order to build the Guest Science Manager APK.

cd $SANDROID_PATH/core_apks/guest_science_manager
$ ANDROID_HOME=$HOME/Android/Sdk ./gradlew assembleDebug

4.6.6. Setting up the network

Setup the network between the Astrobee Simulator and the Android Emulator.

(1) Setting the HOST network

Execute the following commands to open the host file.

sudo nano /etc/hosts

Add 3 lines bellow to the host file and save.

10.42.0.36 hip
10.42.0.35 mlp
10.42.0.34 lIp

(2) Setting the environment variables
Execute the following commands to set the environment variables.
export ANDROID_PATH="${SOURCE_PATH} android"
export EMULATOR=$HOME/Android/Sdk/tools/emulator

export AVD=" AstrobeeAndroidSim”

Note that you need to execute the above commands whenever you open a terminal. If
you write thees commands in your .bashrc file, you don’t have to execute them.
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(3) Setting up the Android network and starting the Android

Emulator

Execute the following commands to set up the Android network and launch the Android
Emulator.

cd SANDROID_PATH/scripts
Jlaunch_emulator.sh -n

4.6.7. Installing APKs

If the Android Emulator is not running, execute the following commands to start it.

cd $SANDROID_PATH/scripts
Jlaunch_emulator.sh -n

In another terminal, execute the following commands to install the Guest Science
Manger APK and your GS APK.

cd $SANDROID_PATH/core_apks/guest_science_manager
adb install -g -r activity/build/outputs/apk/activity-debug.apk
cd <YOUR_APK_PATH>

adb install -g -r app/build/outputs/apk/app-debug.apk

4.6.8. Setting QR codes, an AR tag, and the target

Set QR codes, an AR tag and the target in the Astrobee Simulator in the following steps.

1) Download Kibo-RPC_SimExtMod.zip from the Download page on the Web site.
2) Extract the zip file to directory you want.
3) Execute the following commands.

cd <SETUP MODULE DIR>

chmod +x setup.sh
setup.sh
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4.6.9. Running your program

It's time to run your program!

(1) Launching the Android Emulator

Execute the following commands to launch the Android Emulator.

cd SANDROID_PATH/scripts
Jlaunch_emulator.sh -n

(2) Starting the Astrobee Simulator

Before starting the Astrobee Simulator, execute the following commands to set the ROS
Environment Variables on the other terminal.

export ROS_IP=$(getent hosts llp | awk '{ print $1 }')
export ROS_MASTER_URI=http://${ROS_IP}:11311

Execute the following command to start the Astrobee Simulator.

roslaunch astrobee sim.launch dds:=false robot:=sim_pub rviz:=true
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(3) Running the Guest Science Manager APK and GS APK

Execute the following commands to set the ROS Environment Variables on the other
terminal again.

export ROS_IP=$(getent hosts llp | awk '{ print $1 }')
export ROS_MASTER_URI=http://${ROS_IP}:11311

Execute the following commands to start the Guest Science Manager APK and to
launch the GDS simulator.

$ANDROID_PATH/scripts/gs_manager.sh start
cd $SOURCE_PATH/tools/gds_helper/src
python gds_simulator.py

Operate the GDS simulator to run your GS APK.

1) Press any key to grab control

2) Select your GS APK.

3) Type b and press Enter to start the GS APK.

4) Type d and press Enter to send a custom guest science command.

Then Astrobee starts to locate the leak!
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5. Programming tips
5.1. Do NOT write infinite loops

You must not write any infinite loops in your code because no one can stop Astrobee
while the loop is executing.

You should use finite loops with a defined counter value as shown below.

I NG
while(!result.hasSucceeded() )
/I do something

/I OK

final int LOOP_MAX = 5;

int loopCounter = 0;

while(!result.hasSucceeded() && loopCounter < LOOP_MAX){
/I do something
++loopCounter;
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5.2. Dealing with randomness

You must consider the randomness of the environment.
When you want to move robot below...

// move to point 1
api.moveTo(point1, quaternion1, true);
// move to point 2
api.moveTo(point2, quaternion2, true);
// move to point 3
api.moveTo(point3, quaternion3, true);

If there is no randomness in the environment, this code works well.

However, Astrobee may be faced with errors such as tolerance violations and your
code will not work.

So, you have to provide the redundant code as we see below.
Remember, Do NOT allow any infinite loops in your code!

Result result;
final int LOOP_MAX = 5;

// move to point 1(first try)
result = api.moveTo(point1, quaternion1, true);

/I check result and loop while moveTo api is not succeeded.

// Do NOT write infinite loop.

int loopCounter = 0;

while(!result.hasSucceeded() && loopCounter < LOOP_MAX)

/I retry
result = api.moveTo(point1, quaternion1, true);
++loopCounter;

}

/ move to point 2
/...
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5.3. Camera parameters

If you would like to use camera parameters, you can use the ones given below.
camera_matrix:
rows: 3

cols: 3

data: [344.173397, 0.000000, 630.793795, 0.000000, 344.277922, 487.033834, 0.000000,
0.000000, 1.000000]

distortion_model: plumb_bob
distortion_coefficients:
rows: 1
cols: 5
data: [-0.152963, 0.017530, -0.001107, -0.000210, 0.000000]

5.4. About navigation error

The real world always has uncertainties.Navigation error is one of them and Kibo-RPC
simulator server simulates it.

However, modeling and simulating navigation error completely are complicated and the
calculation load becomes higher,therefore random error following gaussian distribution is
used generally.

Kibo-RPC simulator also implements gaussian distribution and the parameters are as
follows;
Regarding position;

x: mean =0 m and 3sigma = 0.1 m

y: mean = 0 m and 3sigma = 0.1 m

z: mean = 0 m and 3sigma = 0.1 m

Regarding orientation;

x: mean = 0 degree and 3sigma = 3 degree

y: mean = 0 degree and 3sigma = 3 degree

z: mean = 0 degree and 3sigma = 3 degree

You have to consider that self-position and self-orientation obtained from API
(getTrustedRobotKinematics and getTrustedRobotKinematics) includes these error.
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6. Simulator change log

Ver.1.0 Initial Release
Ver.2.0 Add airflow module as a disturbance element.
Add Keep In Zone and Keep Out Zone.
Add simulation playback function.
Visualize of planned path and actual path.
Ver.2.1 Add navigation error as a random factor.

* The version which will be used in preliminary round is the latest version.
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